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COMPUTER:
A computer is a machine that can be instructed to carry 

out sequences of arithmetic or logical operations automatically via computer 
programming. Modern computers have the ability to follow generalized sets of 
operations, called programs. These programs enable computers to perform an 
extremely wide range of tasks. A "complete" computer including the hardware, 
the operating system (main software), and peripheral equipment required and used for 
"full" operation can be referred to as a computer system. This term may as well be used 
for a group of computers that are connected and work together, in particular a computer 
network or computer cluster.

Computers are used as control systems for a wide variety 
of industrial and consumer devices. This includes simple special purpose devices 
like microwave ovens and remote controls, factory devices such as industrial 
robots and computer-aided design, and also general purpose devices like personal 
computers and mobile devices such as smart phones. The Internet is run on computers 
and it connects hundreds of millions of other computers and their users.
CHARATERISTICS OF COMPUTER:
The characteristics of the
computer system are as 
follows −
Speed

A computer works with 
much higher speed and 
accuracy compared to 
humans while performing 
mathematical calculations. 
Computers can process 
millions (1,000,000) of 
instructions per second. The 
time taken by computers for their operations is microseconds and nanoseconds.
Accuracy

Computers perform calculations with 100% accuracy. Errors may occur due to 
data inconsistency or inaccuracy.
Diligence

A computer can perform millions of tasks or calculations with the same 
consistency and accuracy. It doesn’t feel any fatigue or lack of concentration. Its 
memory also makes it superior to that of human beings.

Versatility
Versatility refers to the capability of a computer to perform different kinds of 

works with same accuracy and efficiency.
Reliability

A computer is reliable as it gives consistent result for similar set of data i.e., if we 
give same set of input any number of times, we will get the same result.
Automation

Computer performs all the tasks automatically i.e. it performs tasks without 
manual intervention.
Memory
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A computer has built-in memory called primary memory where it stores data. 
Secondary storage are removable devices such as CDs, pen drives, etc., which are 
also used to store data.
AREAS OF APPLICATION OF COMPUTERS

It is a binding fact that are computers are very productive, efficient and make our 
personal and professional lives more rewarding. These 'magical' machines can do just 
about anything imaginable, moreover they really excel in certain areas. Below is the list 
of some of the principal applications of the computer systems:
Businesses

Businessmen make bar graphs and pie charts from tedious figures to convey 
information with far more impact than numbers alone can covey. Furthermore, 
computers help businesses to predict their future sales, profits, costs etc. making 
companies more accurate in their accounts. Computers may also play a vital role in 
aiding thousands of organizations to make judgmental and hard-provoking decisions 
concerning financial problems and prospective trends.

B 2 B
B 2 C
C 2 C

Buildings
Architects use computer animated graphics to experiment with possible exteriors 

and to give clients a visual walk-through of their proposed buildings. The computers 
provide architects a numerous amount of facilities to create different buildings with 
greater accuracy, better designing and editing tools, and work done at the fastest speed 
possible. Finally, a new kind of artist has emerged, one who uses computers to express 
his or her creativity.
Education

Most good schools in the world have computers available for use in the 
classroom. It has been proved that learning with computers has been more successful 
and this is why numerous forms of new teaching methods have been introduced. This 
enhances the knowledge of the student at a a much faster pace than the old traditional 
methods. Likewise, colleges and various universities have extended the use of 
computers as many educators prefer the 'learning by doing' method - an approach 
uniquely suited to the computer.
Energy

Energy companies use computers to locate oil, coal, natural gas and uranium. 
With the use of these technological machines, these companies can figure out the site 
of a natural resource, its concentration and other related figures. Electric companies use 
computers to monitor vast power networks. In addition, meter readers use hand held 
computers to record how much energy is used each month in homes and offices.
Law Enforcement

Recent innovation in computerised law enforcement include national fingerprint 
files, a national file on the mode of operation of serial killers, and computer modeling of 
DNA, which can be used to match traces from an alleged criminal's body, such as blood 
at a crime scene. In addition, computers also contain a complete databases of all the 
names, pictures and information of such people who choose to break the law.

Transportation
Computers are used in cars to monitor fluid levels, temperatures and electrical 

systems. Computers are also used to help run rapid transit systems, load containerships 
and track railroads cars across the country. An important part is the air control traffic 
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systems, where computers are used to control the flow of traffic between airplanes 
which needs a lot of precision and accuracy to be dealt with.
Money

Computers speed up record keeping and allow banks to offer same-day services 
and even do-it yourself banking over the phone and internet. Computers have helped 
fuel the cashless economy, enabling the widespread use of credit cards, debit cards and 
instantaneous credit checks by banks and retailers. There is also a level of greater 
security when computers are involved in money transactions as there is a better chance 
of detecting forged cheques and using credit/debit cards illegally etc.
Agriculture

Farmers use small computers to help with billing, crop information, and cost per 
acre, feed combinations, and market price checks. Cattle ranchers can also use 
computers for information about livestock breeding and performance.
Government

Among other tasks, the federal government uses computers to forecast the 
weather, to manage parks and historical sites, to process immigrants, to produce social 
security checks and to collect taxes. The most important use of the computer system in 
in this field is perhaps the Army, the Air Force and the Navy. The computers have to be 
very powerful and in order to be run they have to be very accurate and precise. E.g. in 
the use of missiles and other likes, every nanosecond counts, which may save trillions 
of lives on this planet. The government also uses computers in various simulations like 
the spread of influenza in a particular locality.
The Home

People having a computer in the home justifies the fact that it is not only useful 
and efficient, but it is also revered as a learning system. Personal computers are being 
used for innumerous tasks nowadays, for example, to keep records, write letters and 
memos, prepare budgets, produce presentations, draw pictures, publish newsletters and 
most importantly - connect with other in the rest of plant earth.
Health and Medicine

Computers are helping immensely to monitor thee extremely ill in the intensive 
care unit and provide cross-sectional views of the body. This eliminates the need for 
hired nurses to watch the patient twenty-four hours a day, which is greatly tiring and 
error prone. Doctors use computers to assist them in diagnosing certain diseases of the 
sort. This type of computer is called the Expert System, which is basically a collection of 
accumulated expertise in a specific area of field. Computers are now able to map, in 
exquisite detail, the structure of the human cold virus - the first step towards the 
common cold. Furthermore, computers are used greatly in managing patients, doctors, 
wards and medicine records, as well as deal with making appointments, scheduling 
surgeries and other likes.
Manufacturing Industries

Computers have made their way towards jobs that were unpleasant or too 
dangerous for humans to do, such as working hundreds of feet below the earth or 
opening a package that might contain an explosive device. In other industries, 
computers are used to control the production of resources very precisely. All robots and 
machinery are now controlled by various computers, making the production process 
faster and cheaper. All the stages of manufacturing, from designing to production, can 
be done with the use of computer technology with greater diversity.
The Human connection

The computers have evolved in such prosperity that it is now able to assist or aid 
with humans who are disabled - both physically and mentally. The handicapped are now 
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able to express their missing sense with the aid of computer technology. For example, a 
deaf and dumb person is able to communicate extensively with other people by using a 
specially designed computer system. This gives the disabled a chance to live out life 
and gradually catch up with the other fortunate people living on earth.
Scientific Research

This is very important for mankind and with the development of computers; 
scientific research has propelled towards the better a great deal. Because of high-speed 
characteristics of computer systems, systems, researchers can simulate environments, 
emulate physical characteristics and allow scientists to proof of their theories in a cost-
effective manner. Also many test lab animals are spared since computers have taken 
over their roles in extensive research.
Communication with the World

The computes are most popular for their uses to connect with others on the 
World Wide Web. Therefore, communication between two or more parties is possible 
which is relatively cheap considering the old fashioned methods. Emailing, 
teleconferencing and the use of voice messages are very fast, effective and surprisingly 
cheaper as well. When connected to the Internet, people can gain various amounts of 
knowledge, and know about world events as they occur. Purchasing on the Internet is 
also becoming very popular, and has numerous advantages over the traditional 
shopping methods.
Training

It is much more cheaper and effective to teach pilots how to fly in a computerised 
cockpit or simulators, than is real airplanes. This is because the learning pilots will feel 
much more relaxed and confident due to the fact that no life is at risk at that moment. 
Railway engineers can also be given some kind of training on how to run a train with the 
help of a computerised system. Training simulations are relatively cheaper and are 
always available on one-to-one basis making way for personal training.
Paperwork

Computer systems will increasingly cut down the paperwork that is involved in 
millions of industries around the world. If a business is run on a manual system, then the 
amount of papers or registers involved is a great deal, making the administration 
process more tedious and error prone. If it is replaced by a computer system, then all 
the necessary data and information is transferred into the memory of the computer. This 
makes managing various tasks easier, faster and more effective than the manual 
system. Organisations that involve administrative tasks such as a hotel, school, 
hospitals, clubs, libraries etc. will become more efficient if a computer system is 
implemented.
Real Time systems

Many computers provide an environment, which is completely based on real time. 
This means processing of one entity is done so quickly and effectively, that another 
entity is not effected. For example Airline systems and Banking systems will come under 
this category. These systems are immensely huge because they interact with all other 
airlines or baking systems in the world. A computer system, therefore, becomes more 
than just necessary in daily uses.

There are so many applications of computers, that it is impractical to mention all 
of them. This is the Computer Age and these machines are beginning to affect out lives 
in many ways. Computers are now becoming faster, more reliable, effective and whole 
lot cheaper than they had been ever before.
IPO CYCLE:
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IPO stands for Input, Output and Process. As the name suggests, IPO cycle is 
the input and output after process of the data. To get output, u have to first give input 
and then the input needs to be processed to get your desired result, i.e. Output. 
INPUT UNIT

This unit contains devices with the help 
of which we enter data into the computer. This 
unit creates a link between the user and the 
computer. The input devices translate the 
information into a form understandable by the 
computer.
CPU (Central Processing Unit)

CPU is considered as the brain of the 
computer. CPU performs all types of data 
processing operations. It stores data, 
intermediate results, and instructions (program). It controls the operation of all parts of 
the computer.
CPU itself has the following three components −

 ALU (Arithmetic Logic Unit)
 Memory Unit
 Control Unit

OUTPUT UNIT
The output unit consists of devices with the help of which we get the information 

from the computer. This unit is a link between the computer and the users. Output 
devices translate the computer's output into a form understandable by the users.
ALU:

An arithmetic-logic unit (ALU) is the part of a computer processor (CPU) that 
carries out arithmetic and logic operations on the operands in computer instruction 
words. In some processors, the ALU is divided into two units, an arithmetic unit (AU) 
and a logic unit (LU).
MEMORY UNIT:
Memory unit is the amount of data that can be stored in the storage unit. This storage 
capacity is expressed in terms of Bytes.
The following table explains the main memory storage units −

S. No. Unit & Description

1
Bit (Binary Digit)
A binary digit is logical 0 and 1 representing a passive or an active state of a 
component in an electric circuit.

2
Nibble
A group of 4 bits is called nibble.

3
Byte
A group of 8 bits is called byte. A byte is the smallest unit, which can represent 
a data item or a character.
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Word
A computer word, like a byte, is a group of fixed number of bits processed as a 
unit, which varies from computer to computer but is fixed for each computer.
The length of a computer word is called word-size or word length. It may be as 
small as 8 bits or may be as long as 96 bits. A computer stores the information 
in the form of computer words.

The following table lists some higher storage units −

S.No. Unit & Description

1 Kilobyte (KB) 1 KB = 1024 Bytes

2 Megabyte (MB) 1 MB = 1024 KB

3 GigaByte (GB) 1 GB = 1024 MB

4 TeraByte (TB) 1 TB = 1024 GB

5 PetaByte (PB) 1 PB = 1024 TB

CONTROL UNIT:
The control unit (CU) is a component of a computer's central 

processing unit (CPU) that directs the operation of the processor. It tells the computer's 
memory, arithmetic and logic unit and input and output devices how to respond to the 
instructions that have been sent to the processor.
HARDWARE AND SOFTWARE:
HARDWARE:

The physical components of a computer are called hardware.
Ex. Keyboard, mouse, microprocessor, memory, screen, plotter, printer, floppy disk, 
hard disk, optical disk, modem, etc….
SOFTWARE:

A set of programs is called a software. Generally the software are classified as :
SOFTWARE

- SYSTEM SOFTWARE
- APPLICATION SOFTWARE.

SYSTEM SOFTWARE:
System software is software designed to provide a platform for other software. 

Examples of system software include 
operating systems like macOS, GNU/Linux , 
Android and Microsoft Windows, computational 
science software, game engines, industrial 
automation, and software as a service 
applications.
APPLICATION SOFTWARE:

Application software (app for short) is a 
program or group of programs designed for end 
users. Examples of an application include a word 
processor, a spreadsheet, an 
accounting application, a web browser, an email 
client, a media player, a file viewer, simulators, a 
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console game or a photo editor.

OPERATING SYSTEM:
An Operating System (OS) is an interface between a computer user and 

computer hardware. An operating system is a software which performs all the basic 
tasks like file management, memory management, process management, handling 
input and output, and controlling peripheral devices such as disk drives and printers.

Some popular Operating Systems include Linux Operating System, Windows 
Operating System, VMS, OS/400, AIX, z/OS, etc.
Definition

An operating system is a program that acts as an interface between the user and 
the computer hardware and controls the execution of all kinds of programs.
Following are some of important functions of an operating System.

 Memory Management
 Processor Management
 Device Management
 File Management
 Security
 Control over system performance
 Job accounting
 Error detecting aids
 Coordination between other software and users

Memory Management
Memory management refers to management of Primary Memory or Main 

Memory. Main memory is a large array of words or bytes where each word or byte has 
its own address.

Main memory provides a fast storage that can be accessed directly by the CPU. For 
a program to be executed, it must in the main memory. An Operating System does the 
following activities for memory management −

 Keeps tracks of primary memory, i.e., what part of it are in use by whom, what 
part are not in use.

 In multiprogramming, the OS decides which process will get memory when and 
how much.

 Allocates the memory when a process requests it to do so.
 De-allocates the memory when a process no longer needs it or has been 

terminated.
Processor Management

In multiprogramming environment, the OS decides which process gets the 
processor when and for how much time. This function is called process scheduling. An 
Operating System does the following activities for processor management −

 Keeps tracks of processor and status of process. The program responsible for 
this task is known as traffic controller.

 Allocates the processor (CPU) to a process.
 De-allocates processor when a process is no longer required.

Device Management
An Operating System manages device communication via their respective drivers. It 

does the following activities for device management −
 Keeps tracks of all devices. Program responsible for this task is known as the I/O 

controller.
 Decides which process gets the device when and for how much time.
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 Allocates the device in the efficient way.
 De-allocates devices.

File Management
A file system is normally organized into directories for easy navigation and 

usage. These directories may contain files and other directions.
An Operating System does the following activities for file management −

 Keeps track of information, location, uses, status etc. The collective facilities are 
often known as file system.

 Decides who gets the resources.
 Allocates the resources.
 De-allocates the resources.

Other Important Activities
Following are some of the important activities that an Operating System performs −

 Security − By means of password and similar other techniques, it prevents 
unauthorized access to programs and data.

 Control over system performance − Recording delays between request for a 
service and response from the system.

 Job accounting − Keeping track of time and resources used by various jobs and 
users.

 Error detecting aids − Production of dumps, traces, error messages, and other 
debugging and error detecting aids.

 Coordination between other softwares and users − Coordination and 
assignment of compilers, interpreters, assemblers and other software to the 
various users of the computer systems.

Types of Operating Systems
An Operating System performs all the basic tasks like managing file,process, and 

memory. Thus operating system acts as manager of all the resources, i.e. resource
manager. Thus operating system becomes an interface between user and machine.

Types of Operating Systems: Some of the widely used operating systems are as 
follows-
1. Batch Operating System

This type of operating system does not interact with the computer directly. There 
is an operator which takes similar jobs having same requirement and group them into 
batches. It is the responsibility of operator to sort the jobs with similar needs.

Advantages of Batch Operating System:
 It is very difficult to guess or know the time required by any job to complete. 

Processors of the batch systems know how long the job would be when it is in 
queue

 Multiple users can share the batch systems
 The idle time for batch system is very less
 It is easy to manage large work repeatedly in batch systems

Disadvantages of Batch Operating System:
 The computer operators should be well known with batch systems
 Batch systems are hard to debug
 It is sometime costly
 The other jobs will have to wait for an unknown time if any job fails

Examples of Batch based Operating System: Payroll System, Bank Statements etc.
2. Time-Sharing Operating Systems:
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Each task is given some time to execute, so that all the tasks work smoothly. 
Each user gets time of CPU as they use single system. These systems are also known 
as Multitasking Systems. The task can be from single user or from different users also. 
The time that each task gets to execute is called quantum. After this time interval is over 
OS switches over to next task.
Advantages of Time-Sharing OS:
 Each task gets an equal opportunity
 Less chances of duplication of software
 CPU idle time can be reduced

Disadvantages of Time-Sharing OS:
 Reliability problem
 One must have to take care of security and integrity of user programs and data
 Data communication problem

Examples of Time-Sharing OSs are: Multics, Unix etc.
3. Distributed Operating System :

These types of operating system is a recent advancement in the world of 
computer technology and are being widely accepted all-over the world and, that too, 
with a great pace. Various autonomous interconnected computers communicate each 
other using a shared communication network. Independent systems possess their own 
memory unit and CPU. These are referred as loosely coupled systems or distributed 
systems. These system’s processors differ in size and function. The major benefit of 
working with these types of operating system is that it is always possible that one user 
can access the files or software which are not actually present on his system but on 
some other system connected within this network i.e., remote access is enabled within 
the devices connected in that network.
Advantages of Distributed Operating System:
 Failure of one will not affect the other network communication, as all systems are 

independent from each other
 Electronic mail increases the data exchange speed
 Since resources are being shared, computation is highly fast and durable
 Load on host computer reduces
 These systems are easily scalable as many systems can be easily added to the 

network
 Delay in data processing reduces

Disadvantages of Distributed Operating System:
 Failure of the main network will stop the entire communication
 To establish distributed systems the language which are used are not well defined 

yet
 These types of systems are not readily available as they are very expensive. Not 

only that the underlying software is highly complex and not understood well yet
Examples of Distributed Operating System are- LOCUS etc.
4. Network Operating System :

These systems run on a server and provide the capability to manage data, users, 
groups, security, applications, and other networking functions. These type of operating 
systems allow shared access of files, printers, security, applications, and other 
networking functions over a small private network. One more important aspect of 
Network Operating Systems is that all the users are well aware of the underlying 
configuration, of all other users within the network, their individual connections etc. and 
that’s why these computers are popularly known as tightly coupled systems.



10

Advantages of Network Operating System:
 Highly stable centralized servers
 Security concerns are handled through servers
 New technologies and hardware up-gradation are easily integrated to the system
 Server access are possible remotely from different locations and types of systems

Disadvantages of Network Operating System:
 Servers are costly
 User has to depend on central location for most operations
 Maintenance and updates are required regularly

Examples of Network Operating System are: Microsoft Windows Server 2003, 
Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell NetWare, and BSD 
etc.
5. Real-Time Operating System:

These types of OSs serves the real-time systems. The time interval required to 
process and respond to inputs is very small. This time interval is called response time.
Real-time systems are used when there are time requirements are very strict like 
missile systems, air traffic control systems, robots etc.
Two types of Real-Time Operating System which are as follows:
 Hard Real-Time Systems:

These OSs are meant for the applications where time constraints are very strict and 
even the shortest possible delay is not acceptable. These systems are built for 
saving life like automatic parachutes or air bags which are required to be readily 
available in case of any accident. Virtual memory is almost never found in these 
systems.

 Soft Real-Time Systems:
These OSs are for applications where for time-constraint is less strict.

Advantages of RTOS:
 Maximum Consumption: Maximum utilization of devices and system,thus more 

output from all the resources
 Task Shifting: Time assigned for shifting tasks in these systems are very less. For 

example in older systems it takes about 10 micro seconds in shifting one task to 
another and in latest systems it takes 3 micro seconds.

 Focus on Application: Focus on running applications and less importance to 
applications which are in queue.

 Real time operating system in embedded system: Since size of programs are 
small, RTOS can also be used in embedded systems like in transport and others.

 Error Free: These types of systems are error free.
 Memory Allocation: Memory allocation is best managed in these type of systems.

Disadvantages of RTOS:
 Limited Tasks: Very few tasks run at the same time and their concentration is very 

less on few applications to avoid errors.
 Use heavy system resources: Sometimes the system resources are not so good 

and they are expensive as well.
 Complex Algorithms: The algorithms are very complex and difficult for the 

designer to write on.
 Device driver and interrupt signals: It needs specific device drivers and interrupt 

signals to response earliest to interrupts.
 Thread Priority: It is not good to set thread priority as these systems are very less 

prone to switching tasks.
Introduction on Windows:
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Microsoft Windows, commonly referred to as Windows, is a group of 
several proprietary graphical operating system families, all of which are developed and 
marketed by Microsoft. Each family caters to a certain sector of the computing industry. 
Active Microsoft Windows families include Windows NT and Windows IoT; these may 
encompass subfamilies, e.g. Windows Server or Windows Embedded 
Compact (Windows CE). Defunct Microsoft Windows families include Windows 
9x, Windows Mobile and Windows Phone.

Microsoft introduced an operating environment named Windows on November 
20, 1985, as a graphical operating system shell for MS-DOS in response to the growing 
interest in graphical user interfaces (GUIs).[3] Microsoft Windows came to dominate the 
world's personal computer (PC) market with over 90% market share, overtaking Mac 
OS, which had been introduced in 1984. Apple came to see Windows as an unfair 
encroachment on their innovation in GUI development as implemented on products 
such as the Lisa and Macintosh (eventually settled in court in Microsoft's favor in 1993). 
On PCs, Windows is still the most popular operating system. However, in 2014, 
Microsoft admitted losing the majority of the overall operating system market to Android, 
because of the massive growth in sales of Android smartphones. In 2014, the number 
of Windows devices sold was less than 25% that of Android devices sold. This 
comparison, however, may not be fully relevant, as the two operating systems 
traditionally target different platforms. Still, numbers for server use of Windows (that are 
comparable to competitors) show one third market share, similar to that for end user 
use.
Logging On:

Logging on is a security measure that is enforced before allowing users to gain 
access to a computer system, a network, an email account or a restricted area of a 
website. The procedure typically requires users to provide identification information 
such as a username or email. It is also the simplest way to protect a system from 
outsiders.Logging on is also known as logging in, signing in and signing on.
Getting started with Windows XP

Introduction to Windows XP tutorial
Windows XP is an operating system. The program helps in starting your computer. 
Windows XP functions as a platform for applications like Word, PowerPoint, Excel, 
CorelDraw, Internet Explorer, and many others. It controls and handles all kinds of 
hardware, including RAM and cards
Windows XP comes as a program package. The package includes independent user 
programs like Windows Media Player and Internet Explorer.
All about the Windows XP interface - 1
What is Windows XP?
Windows XP is an operating system produced by Microsoft Corporation for use on 
personal computers running x86 and IA-64
processors. The name "XP" stands for "experience". Windows XP was first  released  
on 25 October 2001. Windows XP presents a graphical user interface (the visible part of 
the software), regarded as more user-friendly than previous versions of Windows. The  
Windows  XP user interface consists of the desktop, taskbar, start menu and desktop 
items.  Windows XP is the  most  widely  used  operating system in the world. The 
earlier versions of Windows XP are Windows 98, Windows 2000, and Windows ME.

What is a Window?
A window is an enclosed, rectangular area on the PC display screen. Graphical user 
interfaces (GUIs) allow you to divide your display into several  windows. Within each 
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window, you can run a different program or display different data.
What is an Icon?
An icon is a small picture representing the program running in the window. Every 
application in Windows XP has their own set of icons that visually distinguishes 
themselves from the other.
What is a Shortcut?
In Windows, a shortcut is an icon used to represent a document, folder, or 
program file. You can open a file or launch an application by clicking the 
shortcut icon.
What is a Menu?—common menu types
A menu is a set of options presented to the user of a computer application to help the 
user find information or execute a program function. Menus are common in graphical 
user interfaces (GUIs) such as Windows.
Common menu types are File Menu, Edit Menu, Format Menu and Help Menu. What is a 
Dialog Box?

In graphical user interfaces, a dialog
(or dialogue) box is a special window 
that displays information to the user,  
or to get a response if needed. They 
are called dialog because they form a 
dialog between the computer and the 
user—either informing the user of 
something, or requesting input from  
the user, or both.

A simple type of dialog box is the 
alert, which displays a message and

requires just an acknowledgment (by clicking 'OK' usually) that the message has been 
read.
What are Tabs?
Tab(s) is the name for a way to display information on websites. Website tabs resemble 
manilla folder tabs - that part of the folder that sticks out so it can be labeled and seen. 
Clicking on the text of the tab shows you a different view in the same browser window.

All about the Windows XP interface - 2
What are Fields?
A field is a space assigned for a specific item of information. In Windows  XP,  fields are 
also referred to as text boxes. In the Save As dialog box, for example, you type the
name you choose your file to have in the File Name field.
What are List Boxes?
List boxes allow you to choose an option from a list of options. To select a specific 
option, just click on that specific option. Some list boxes allow you to
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choose multiple options. To select more than one option, hold down the Ctrl key while 
clicking. A scrollbar appears on the side of the list box when there are many options that 
cannot be displayed in  the box. You can utilize the scrollbar to display the extra choices.
What is a Drop-Down Menu?
Drop-down menu is a set of options that appear in a rectangular box under a menu item, 
when the user clicks it.
Drop-down menus are also found in association with fields. You can click the downward-
pointing arrow to display a list of options. Select your chosen option from the list. If you wish 
to open a drop-down menu from  the keyboard,  hold  down the Alt key and press the down
arrow.
What are Radio Buttons?

Radio buttons are a type of GUI element  in Windows  that 
allows user to select a predefined option, from a set   of 
options. Radio buttons allow users to select only one option at  
a time.  An unselected radio button looks  like   a white 
circular ring. When selected,  a  black  dot appears in the 
middle, indicating as selected.

What are Check Boxes?
Check boxes are a type of GUI element in Windows that allows user to select a predefined 
option, from a set of options. Check boxes allow users to select more than one option at a 
time. An unselected check box looks like a white square box. When selected, a ‘X’ appears in 
the middle, indicating as selected.

Set of arrows situated on a text box side is termed a spinner. The up arrow increases the
value and the down arrow decreases the value. Values can also be typed into the text box.
What is a Color Box?
The color box displays a wide range of color options. 48 basic colors  are  available. To 
select a specific color, click on that color square. A maximum of 16 custom colors can be 
saved in Windows XP. If you wish to select a custom color, click the Define Custom Color 
button. Hue, Saturation, Luminosity  (HSL)  and Red, Green, Blue (RGB) values are 
displayed at the bottom of the color box. You can add your selected color to the Custom 
Color square by clicking the Add to Custom Colors button.
All about the Desktop and its properties

Icon arrangement
The simplest way to rearrange the icons on your desktop is to simply drag and drop them. 
You can drag an icon to any location on your desktop.
However, dragging and dropping your icons can lead to icons not aligning in neat
columns and rows. If you want neat columns and rows of icons, you can have Windows 
automatically arrange them for you. Simply right-click your desktop, click Arrange Icons
By, and then click Align to Grid. Windows XP does not immediately move your icons. 
However, the next time you drag an icon, Windows XP will automatically place it into an
orderly row.
To automatically arrange your icons into rows without changing their order, right-click 
your desktop, click Arrange Icons By, and then click Auto Arrange. Windows XP places 
your icons into neat rows.
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Utilities in Windows XP
What is a compressed (zipped) Folder?
Compressing files, folders, and programs decreases their size and reduces the space they 
use on your drives or
removable storage devices. Windows XP has its own built-in zip support.
This means you do not need third party software to open compressed files. In Windows XP, to 
compress an existing folder simply right click, point to Send To, and click Compressed (zipped) 
folder. The Compressed (zipped) Folder is located at C:\Documents and Settings\ Default 
User\Send to folder.
How to create a Compressed (zipped) Folder?
To create a Compressed (zipped) Folder, right-click a blank area on the desktop  or in an 
open folder, point to New and then click Compressed (zipped) Folder.
Type a name for the new compressed folder, and then press ENTER. Your new compressed 
folder is displayed as a folder  icon  with  a  zipper.  Depending  on your preferences, a.zip file 
name extension may also appear.

How to extract files from a Compressed (zipped) Folder?
Getting files or folders out of a compressed folder is known as  extracting them. You can 
extract one file or folder at a time, or you can extract multiple files or folders. To extract a 
single file or folder, follow thesesteps:

� Double-click the compressed folder to open it.
� Then, drag the file or folder from the compressed folder to a new 

location.
CD Writing Wizard
The Windows XP package includes the CD Writing  Wizard.  Built-in support for  CD burning 
makes the task easier than ever before—as easy as copying to a floppy disk.

Using Windows XP, you can copy tracks either to a compact disk-recorder (CD-
R) or to a compact disk-rewritable (CD-RW).

Summary
Windows XP is an operating system and acts as a platform for other computer applications. 
You require Windows XP to run popular programs like Microsoft Word, Microsoft Excel and 
CorelDraw among many others.

You can now identify various components of Windows Graphical Use Interface (GUI). 
Functions of components like icons, dialog boxes, list boxes and tabs are also known to you. 
Difference between checkboxes and radio buttons is also elaborated. Importance of Taskbar is 
explained.

You have learnt how to personalize your computer. You now know how to change themes 
and the entertainment value of screensavers. The Start menu provides quick access to 
frequently used programs. You now know which desktop icons are available by default and 
how to restore and remove these icons.
You now have a fair knowledge of graphical user interface in Windows Explorer. File systems 
can be accessed through this program. Control of the computer is also done via Windows 
Explorer.

"My Computer" displays storage area inside your computer. If you wish to share information
with other persons, store your files and folders in Shared Documents folder. Knowledge about 
"Cut", "Copy" and "Paste" functions enable you to copy text or an object from one place to
another.
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MS – Word:
Introduction

Word processing software is one of the miracles of the modern age. It evolved 
from the needs of writers as word processing software gives users an 
extensive set of tools for working with text. It is used to create all kinds of 
documents, from simple notes and memos, to brochures, resumes, and long 
reports.

A word processor is a computer program used to create and print text 
documents that might otherwise be prepared on a typewriter. The key 
advantage of a word processor is its ability to make changes easily, such as 
correcting spelling, adding, deleting, and relocating text. Once created, the 
document can be printed quickly and accurately and saved for later
modifications.
The most recent word processors are practically powerful editing devices that 
only a few years ago would have been the envy of professional printers. But it 
is not only a matter of graphical arrangement and page layout, the effects of 
writing through this medium are far reaching on a number of more profound 
levels.
A number of softwares are available for word processing like Microsoft Word, 
Lotus WordPro or WordPerfect etc. Although these are expensive and 
sophisticated products, many of the facilities of word processing are also to be 
found in free software, like Microsoft WordPad, which comes as part of the 
Microsoft Windows standard installation. If one cannot afford to purchase a 
word processing application, then there are many powerful programs free, 
either as downloads from the Web or on cover disks with magazines. A word 
processing program is a good introductory program to learn for two important 
reasons:

 Word processors are good examples of competing programs that all 
run and work in essentially the same way. Learning one program 
allows us to use almost all of the competing programs.

 Skills such as saving, copying, pasting, formatting, printing, and using 
old files as templates for new work are easy to understand within word 
processors. Many of the skills utilized in word processing programs are 
used in other popular applications such as spreadsheets, web 
browsers and e-mail programs.

Concept of Word Processing Software
The word processor is the modern version of paper, pen, typewriter, eraser, 
dictionary and thesaurus… all in one. They were introduced on the market in 
the 1960s and became a typical office tool by the 1970s. Modern word 
processors display  documents in graphics mode, thus enhancing the 
WYSIWYG function (What You See Is What You Get); this means that the 
way the text and images are displayed on the screen is the way they will 
appear when printed. Their formatting features include font changes, page 
layout, and paragraph indention. They also check spelling, find synonyms, 
incorporate graphics, perform calculations, and so on.
The basic concept of word processing software is that one can type the text 
into the computer, instead of onto paper. Then errors can be corrected, text 
can be rearranged and all sorts of modifications can be made. It can then be 
seen on the screen and if we are satisfied with it, then only take a print-out on 
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paper. It is a four steps process-type, store, edit, and print.

A word processor is software that enables us to write, edit, format, and print 
text. As we type on a keyboard, the words appear on the screen to see. 
Mistakes can be corrected easily before printing the text on paper. Words, 
sentences, and even entire paragraphs can be moved by special commands. 
Nothing is printed until we are satisfied with the results. Word processor and 
the hardware simply provide a convenient way to display, store, edit, and 
recall the work done.

Standard Features of Word Processing Software
 Word-wrap: automatic arrangement of text in lines of specified length 

without the necessity of touching the return key.
 Discretionary Hyphenation: option of inserting a hyphen to break a 

word that ends a line: the hyphen does not print if later editing moves 
the word to the middle of a line.

 Justification: automatic alignment of text to both the left and right margins.
 Adjustment: realignment of text to new margin and tab settings.
 Alignment: positioning text or numbers to specified margin and tab

settings.
 Decimal Alignment: positioning columns of numbers with the decimal 

points vertically aligned.
 Indents: the setting of temporary margins within a document differing 

from the primary margins used.
 Centering text on a line.
 Insertion: the entry of new text within previously typed material without 

erasing the existing material.
 Overstriking: the substitution of new text for old by typing over the old text.
 Deletion: erasure of text from the screen, or of whole documents from 

the disk.
 Search and Replace: moving directly to specified words or parts of 

words within a document and replacing them with different words or 
word portions.

 Copying or Cutting: the duplication or moving of blocks of text within 
a document.

 Boilerplate: the separate storage and retrieval of blocks of text from 
which standard documents can be built.

 Pagination: automatic division of a document into pages of specified 
numbers of lines.

 Page Numbering: automatic sequential numbering of pages.
 Line spacing: Line spacing or leading is used to change the amount of 

space between lines of text. Normal text is single line spaced. This
can be altered to
1.5 times or double or a number of points. Leading is a term which 
originates from typesetters who used strips of lead to place in-between 
the lines of text to increase the amount of space between each line.

 Headers and Footers: option of creating standard blocks of text that 
will automatically appear at the top or bottom of each page in a
document.

 Footnoting: automatic sequential numbering of footnotes and 
positioning of the footnotes at the bottom of their appropriate pages 
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during pagination.
 Table of Contents and Index Generators. Programs that create these 

based on the text of a document.
 Form Letter Merging: automatic combining of a form letter with a 

mailing list to generate multiple copies of the letter with the different 
addresses and other variable information filled in.

 Automatic Spelling Checker and Corrector. Program that compares 
words in the text against an on-line dictionary, flagging items not found 
in the dictionary and offering alternative spellings and a means of 
correcting the errors.

In this chapter, we will learn how to use Microsoft Word assaulted with the 
above features.

Getting Started with Microsoft Word
Before getting started with Microsoft Word, we need to locate and open it from 
the computer desktop. On computer, we should be able to see a MS Word 
icon on the desktop. From the computer desktop:

1. Double-click on the MS Word icon 
Go to the Start menu if the MS Word icon is not on the desktop:
1. Click ►Start ►Programs ►Microsoft Word

MS Word will open a blank page called Document 1.
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Structure of Microsoft Word Window
When you open the word a blank document opens. You can start typing on it 
directly. But for performing various other options you have to learn about the 
different components in the window and the options under these bars.
1. Title Bar: Title bar shows the name of the document and is situated in the 
top of the window application.
2. Menu Bar: Menu bar contains the various commands under the various 
topics to perform some special tasks. Menu bar is located under the title bar.
3. Standard Toolbar: Toolbar is nothing more than the shortcut of the Menu 
options to execute or perform the menu options in the easiest and fastest way. 
Standard toolbar contains the commands for the Word’s most frequently used
commands.
4. Formatting Toolbar: Formatting toolbar contains the various commands 
related to the formatting of the document.
5. Ruler: From Ruler margins and indents can be adjusted in the easier way 
and it also provides measurement for the page formatting.
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Microsoft Word Window
6. Cursor: Cursor is Word pointer, which tells that from or on the cursor 
position you can perform your action.
7. Drawing Toolbar: Drawing toolbar has the various commands related to 
the graphics and the drawing options.
8. Status Bar: It displays the positioning of the cursor, displays the status of 
some important keys of keyboard, shows the messages for the toolbar button
when a mouse
points to it, displays messages for menu option when a menu option is
selected or pointed out by a user.
9. View Buttons: View buttons are shortcuts of various views in the View Menu.
10. Scroll Bars: There are two types of scroll bars

i. Horizontal Scrollbar
ii. Vertical Scrollbar

Working of both the scroll bar is to scroll the document in either direction.
11. Document Navigator: Document Navigator allows navigating the 
document in different types of objects and is activated when clicked on the 
ball type button on the vertical scroll bar.
12. Office Assistant: Office assistant provides you the online help, real-time 
tips while working.
Common Key Definitions in a Word Processor

Action Key or Key Combination

Moves Left or Right one chara cter � Or �

Moves Left or Right one word Ctrl + � or Ctrl + �

Moves Up or Down one line � Or �

Moves Up or Down one paragraph Ctrl + � or Ctrl + �

Moves to the start or end of a line Home or End

Moves Up or Down one screen Page up or Page Down

Moves to the top or bottom of the current 
screen

Ctrl + Page up or Ctrl + Page 
Down

Moves to the start or end of the documentCtrl + Home or Ctrl + End

Working with Word Document - File Related Operations
When WORD is opened you will be presented with a blank page. All what you 
have to do is start writing. Of course you don’t have to worry about 
overflowing the text line because the program will take care of breaking it up 
appropriately. After writing your first document you have to save it; if you don’t 
and turn off the computer what you have written will be cancelled and nothing 
will remain. However the program asks you what you want to do of the 
document the moment you shut off WORD without having saved it first. If you 
intend to keep the document you will be prompted
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to tell the computer where you want to save it. By default it will be saved as a 
file in a folder called My Documents. Give a name to the document and 
choose the file’s destination: it will be saved with a .DOC extension; this is to 
tell Windows that this document is a WORD file. From now on the document 
you have written will be available for you to do whatever you like: you can 
open it again and modify it, or  print it, or send it via e-mail or fax. We can do 
all file or document related operations from FILE menu.

Open a New File: To open a new file, Click on the File menu. Then Click on 
the new option or you can directly press the Ctrl+N from the keyboard. Select 
the Blank document from the General Tab from the following dialog box and 
then press OK button.

Save a Document: For saving a document, Click on the File►Save option. 
OR Press Ctrl+S OR Press the Save tool from standard toolbar.

If you are saving the file for the first time the Save as window will appear. 
Choose the appropriate folder from Save in combo box. Write the proper file 
name in the File name text box. And then press the Save button

Save and Save As options do the same work of saving a document but the 
difference between both options is that the Save As command every time 
gives you the Save As dialog box and you can save the file with different 
names also. But the Save option will gives you the Save As dialog box when 
you are saving the document for very  first time. Other times it will save the 
document with the previous name without giving any dialog box.
Opening of an Existing Document: To open an existing document, Select 
the Open option from the File menu OR Press Ctrl+O OR Click on the Open 
tool from the standard toolbar. Then the open dialog box will appear. Select 
the appropriate folder from Look in combo box. Select the required file from 
the file window Or Write the required file’s name in the File name window. 
Click on open button on the right hand side.

Page Setup: Click ►File ►Page Setup
Note. If you can not see Page Setup, scroll down to the two little arrows 
pointing down and click once to see the entire menu.
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A Page Setup window will appear. From the Page setup option one can setup 
the page layout according to the job. You can adjust the different margins or 
apply different options from the margin tab where:
i) In top margin enter the distance you want between the top of the page 

and the top of the first line on the page.
ii) In Bottom margin enter the distance you want between the bottom of 

the page and the bottom of the last line on the page.
iii) In Left option enters the distance you want between the left edge of the 

page and the left edge of unindented lines.
iv) In Right option enter the distance you want between the right edge of 

the page and the right end of a line with no right indent.
v) In Gutter option enter the amount of extra space you want to add to the 

margin for binding. Word adds the extra space to the left margin of
all pages if you
clear the Mirror margins check box, or to the inside margin of all pages 
if you select the Mirror margins check box.

vi) In Header option under From edge frame enter the distance you want 
from the top edge of the paper to the top edge of the header. If the 
Header setting is larger than the Top setting, Word prints the body text 
below the header.

vii) In Footer option under From edge frame, enter the distance you want 
from the bottom edge of the paper to the bottom edge of the footer. If 
the Footer setting is larger than the Bottom setting, Word stops printing 
the body text above the footer.

viii) Check Mirror margin check box to Adjusts left and right margins so that 
when you print on both sides of the page the inside margins of facing 
pages are the same width and the outside margins are the same width.

ix) Check the 2 pages per sheet checkbox to Print the second page of a 
document on the first page. This check box is used when the printed 
page is folded in half with the two pages on the inside. The outer 
margins (gutter) of the page will be the same width, and the inner 
margins will be the same width.

x) In the Apply to list box, Click the portion of the document you want to 
apply the current settings to in the Page Setup dialog box. And the 
options of this list box are Whole document, This point forward etc can 
be changed according to the situation.
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Sometimes we create documents that do not fit on a standard piece of paper 
in its normal standing up position. If you are creating something by hand then 
you can simply turn the page so it is lying on its side. With MS Word you can 
change the orientation of your page anytime you want while you are creating 
your document.
To change the orientation of your document to landscape (sideways):
From the Paper size tab you can set the length or width of the page. When 
you click on the Paper size tab the following window will appear.

1. Click on the Paper Size tab
2. Click in the circle besides Landscape
3. Click ►OK
Your document should now be in a landscape position. If you wish to place it 
back in a portrait position, go through the same steps but instead of clicking in 
the circle besides Landscape, click in the circle besides Portrait.

In the above window you can adjust the following:
i) From Paper size list box you can select the predefined Paper sizes.
ii) From Width and Height text boxes the custom Paper size can be defined 

by adjusting the Height and width of the paper.
iii) Select the orientation of the paper from Landscape or Portrait orientation

frame.

Print Option: For taking the printout you have to select the print option of the 
file menu. To print your MS Word document:

i) Click ►File ►Print from the menu bar and a Print window will come up 
on the screen

ii) Click ►OK for it to start printing OR
iii) Change some of the automatic settings first, such as which pages or how 

many copies will be printed
iv) Click ►OK to start printing



23

You can set various options before taking the printout.
i) From the Name combo box you can select the printer if more than one 

printer is installed.
ii) You can select the range of pages i.e. all pages or current page or 

number of pages you require from Page range frame.
iii) From the print what option you can choose which part of a document you 

want to print i.e. the whole document or comments or anything else.
iv) From print option the types of pages can be selected to print i.e. all 

pages or even pages or odd pages.
v) You can choose number of copies from Number of copies option under 

Copies frame.
vi) From Pages per sheet option under Zoom frame you can Select the 

number of pages in the document that you want to print on each sheet of
paper.

vii) From scale to paper size option you can select the paper size on which 
you want to print the document. For example, you can specify that a B4-
size document prints on A4-size paper by decreasing the size of the font 
and the graphics. This feature is similar to the reduce/enlarge feature on 
a photocopy machine.

The collate check box can print the copies of the document in proper binding 
order.
If you want to check what your document will look like before you print:

i) Click ►File ►Print Preview from the menu bar at the top or Click on
the

Print Preview icon on the standard toolbar
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ii) Click on Close at the top of the Print Preview page to go back to the 
regular view

Closing MS Word: Be sure to leave yourself enough time to save or print 
your work before the end of your session. When you are finished, Click ►File 
►Exit from the menu bar OR Click on the X in the top right corner of the 
computer screen

Some Important Editing Functions
When you start up a word-processing program, a window will appear for 
entering text, with a ruler above to indicate the paper width. You will probably 
also see lots of little buttons with pictures on them, as seen below. The 
buttons are shortcuts to certain popular commands. If you hover your mouse 
over these buttons (without clicking) a little tag will appear telling you what the 
button does.

The cursor (called a 'flashing i-beam') will blink on an off, indicating the text 
insertion point. Anything typed will appear at the insertion point. By clicking 
the mouse within the typed text, you can reposition the cursor. Additional text 
can then by typed, or text can be deleted:

Cut, Copy, Paste and Copy Format:

To copy words, portions of text, images, or just about whatever you have in 
your document, you can click on the COPY icon or hit Ctrl+C; this will 
memorize what you have copied in the clipboard and you can paste it any 
place you want by clicking on the PASTE icon or hitting the keys Ctrl+V. 
However, if you wish to delete something in order to copy it somewhere else, 
use the CUT command (the scissors icon) or hit Ctrl+X.
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Finally, clicking on COPY FORMAT (the brush icon) you can format text as 
you wish: to do so, position your pointer on the word whose format you want 
to copy; click on COPY FORMAT icon; move pointer to word or text you want 
to modify and highlight it with your mouse, and finally release the mouse 
button. The text will show the new format (font, character size and colour).

Reverse Commands:

To reverse changes while editing, undo command is used. To perform
undo you can Click on the Undo option under Edit menu Or Click on the
Undo button on
Standard toolbar Or Press Ctrl+Z.

If an undo has to perform on last reversed action that is known as Redo  
. To perform redo you can Click on the Redo option under Edit Menu Or Click 
on the Undo button on Standard Toolbar Or Press Ctrl+Y

Find, Replace And Go To Options:
Find: Some times while working in document you need to find a particular 
text. To find a particular text click on the Edit menu, click Find or Ctrl+F. Then 
you will see the window shown below. In the Find what box, enter the text that 
you want to search for. Select the direction of searching from Search list box. 
Select any other options that you want.

Match case: To find the characters that are a word by themselves and are not a 
part of another word.
Find whole words only: To find the characters that are a word by themselves 
and are not a part of another word.
Use wildcards: To specify the wildcard characters (? Or *) in the Find what 
text box Sounds like: To find words that sound similar but are spelt differently. 
For example hair, heir, hear and hare sound similar to here.
Find all word forms: To find all grammatical forms of the word. For example, 
on entering the word eat it also searches ate, eaten and eating words.
If you want find similar word again in the rest of the document click on the Find 
next button.
Replace: If you have to replace a word in the document with another word you 
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can use find and replace command. On the Edit menu, click Replace or 
Ctrl+H. Then you will find a window.

The Find what box, enter the text that you want to search for. In the Replace 
with box, enter the replacement text. Select any other options that you want. 
Click Find Next, Replace, or Replace All. To cancel a search in progress, 
press ESC.

Go to: To go to on a particular location or particular item use Go to option 
under the Edit menu click on the Go to option under the Edit menu or Ctrl+G. 
Then the following window will appear on the screen.

Select according to what you want to navigate in the document from Go to 
what combo box. Enter the parameter as page number or name of the 
bookmark. Click on the previous or next depending upon the direction you 
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want to go.
Formatting a Document:
Once the text of a document has been typed, it is required to be formatted. 
MS-Word provides Format menu to give a meaningful format of your 
document, so that a user can read and understand the document in an easy 
manner. Following are the options available in the Format menu.

Text Formatting: Format of font i.e. the font type, font size, font style, font 
Color, character spacing etc. can be changed by going in the option Font of 
Format menu.

Changing of Fonts: The word font means the way of writing characters. To 
change the font-using Font dialog box gives you the opportunity to see the 
result within the dialog box before applying it on the text. Other benefit of 
using the font dialog box is that you can apply several effects within the same 
dialog box like font color, bold or font size etc. Select the desired text to 
change the font. Select the Font option from Format menu. A window will 
appear on the screen. Scroll through the Font list and click the font that you 
want. Select the font color, underline style and Effects of your choice. Select 
the font style according to the text. Click on Ok button

Paragraphs Formatting:
Alignment of the Paragraph: Alignment refers to the way the right and left 
edges of a paragraph line up along the right and left margins of your 
document. Word gives you four alignment choices - left, centered, right and
justified.
Working with Columns: You can use columns to create documents such as 
newsletters or book pages. The column option controls the width and number 
of columns. Narrower column widths make your text easier to read. Often, 
creating columns enables you to fit more text on a single page. Columns work 
particularly well where you have several shorter topics making up a larger 
document, as with a newspaper. To create a column selects the text which 
you want to convert in column Click on the column button in the Standard 
toolbar. A drop-down list appears with four columns across it. Click on the first 
column in the drop-down list and drag across to highlight desired number of
columns.

Center Ali gned

Left Aligned

Justified

Right Ali gned
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Zoom In and Out of Text:

It is worth mentioning here that the zoom function that is on the standard tool 
bar of WORD can be used to zoom in and out the text, this way even if you 
decide for a very small font size you don't have to kill your eyes to read what 
you are writing. Simply select a higher value on the pull down menu or directly 
type in a value in the box.

Spelling Checker:
Another important feature is the Spelling Checker and vocabulary, whereas 
the Grammar Checker is highly unreliable yet and therefore not so useful. 
Normally most modern WORD versions have this feature of English in-built 
vocabulary that may be an invaluable helping tool for synonyms and 
antonyms. To activate this function, position the pointer on the word you want 
to check and hit F7 key, or alternatively right-click on your mouse and work 
through the pop-up menu.

Microsoft Word automatically underlines any words that it does not recognize 
in red, assuming that they are not spelled right. Right-click the red underlined 
word and click on either one of the corrections suggested or Ignore, to make 
no changes or add, to make no changes but to add the word to Microsoft 
Word’s list of words that it thinks are spelled correctly. This is especially useful 
for names of people or places that you type often, so that Word will not think it 
is wrong the next time it sees it.

Green underlines mean that Microsoft Word thinks there is something wrong 
with the way the sentence is written. Right-click the underlined words and 
either click on the corrections suggested or click Ignore.

Inserting Images From Clip Gallery:
To insert an image from Clip Gallery you have to move the cursor where you 
want to insert the image. Select Clip art option from Insert ►Picture menu. 
Click the picture category from which you want to insert the picture. If you 
know what type of image you’re looking for, type a descriptive word or two in 
the Search for Clips text box, and press Enter. Word displays the images that 
are most closely match your keywords. When you find out the image that you 
want to use, click it. Clicking on the image will display a small toolbar. From 
that toolbar, click the Insert button as given in the figure given below. This will 
insert a clipart in your document.

insert
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Mail Merge
Mail merge is a pretty simple concept. Mail merge allows standard letters to 
be 'personalized' by merging it with data from a database. The result is a 
batch of letters which contain virtually the same information with the exception 
of names, addresses and any other information stored in a database.

You take a document (such as a form letter) and a set of information (such as 
the names and addresses of all your clients) and merge them. When you 
merge the form letter and the list of names, you can generate a mass mailing. 
Each copy of the document you print will be personalized with a different 
name and address. Typing the letter once, combining it with your client list, 
and printing it can therefore accomplish a mailing to hundreds of clients.

Before you start learning mail merge process, you need to understand the two 
documents that make up a mail merge:

1. Main Document: In a mail-merge operation, the document containing the 
text and graphics stays the same for each version of the merged document. 
For example, the return address and the body of a form letter.
2. Data Source: A file that contains the text and graphics that varies with each 
version of a mail-merge document. For example, a list of names and
addresses for a form
letter you want to send to a list of client’s or in any report in which you want to 
use information from a database.

Creating the Main Document
The main document can be a form letter, an invoice, an invitation or any type 
of document. The idea here is that the document will go to many recipients, 
and some unique information must be included to personalize it.

If you have an existing letter that you want to use for your form letter, open it, 
and modify it according to your need or if you want to start a letter from 
scratch, start a new blank document. Save the document. Choose tools, Mail 
Merge to display the Mail Merge Helper Dialog box. Click the Create button. 
Select Form Letter from the drop-down list. A dialog box will appears with two 
choices: to create a form letter within the active window or in new window. 
Click the Active window Button. Click on edit button if you haven’t written the 
letter body.
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<<TITLE>> <<FORENAME>> <<SURNAME>>

<<ADDRESS 1>>

<<ADDRESS 2>>

<<POST CODE>>

Dear <<TITLE>> <<SURNAME>>,

You have been selected among thousands of people to take part in our prize draw to win Rs. 10,000. A 

A standard letter is written and mail merge markers are placed in it to show 
where the data from the database will be inserted into the letter to personalize 
it.
Building Data Source
In this second phase, you tell Word which document you want to use as your 
data source. You can either create a new one or open an existing one.

A data source is a file that contains the data that varies in each copy of a 
merged document. For example, a data source can include the name and 
address of each recipient of a form letter.

Create a New Word Data Source
Make sure you've already set up the main document. If you don't see the Mail 
Merge Helper dialog box, click in the main document, and then click Mail 
Merge on the Tools menu. Under Data source, click Get Data, and then click 
Create Data Source.

In the Field names in header row box, specify the data fields (A category of 
information in a data source. A data field corresponds to one column of 
information in

the data source. The name of each data field is listed in the first row (header 
row) of the data source. "PostalCode" and "LastName" are examples of data 
field names.) that you want to include in the data source. To delete a data 
field, click the field name in the Field names in header row box, and then click 
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Remove Field Name. To add a data field, type a new field name in the Field 
name box, and then click Add Field Name. To change the order of the data 
fields, click a field name in the Field names in header row box, and then click 
one of the arrow buttons. When you finish specifying the data fields, click OK. 
Locate the folder that you want to save the data source in, type a file name, 
and then click Save.
Click Edit Data Source.

In the Data Form dialog box, fill in the information for each data record (A 
complete set of related information in a data source. A data record 
corresponds to one row of information in the data source. All information 
about one client in a client mailing list is an example of a data record. To fill in 
a record, type information for a data field, and then press ENTER to move to 
the next field. If you don't want to include information for a particular field, 
press ENTER to skip the field. Don't type spaces in the box. To start a new 
data record, click Add New.

To return to the main document, click Mail Merge Main Document on the 
Database toolbar.

Mail Mer ge Main

Now the main document displays out with the new toolbar of Mail Merge
Inserting the Merge Fields
It’s time to enter merge fields in the form letter you typed. The merge fields in 
the letter will correspond to the fields in your database. Place your cursor 
halfway between the date and salutation. Choose the Insert Merge field’s 
button on the Mail Merge toolbar.
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Word inserts the merge field surrounded by chevron brackets. Insert the 
remaining merge fields in the address block, pressing Enter and adding 
spaces and commas where necessary. If you have a salutation field, add it 
after Dear, and follow it with a colon or comma. Save the main document.

Merging Document and DATA 
Merging to a Printer or 
Document
Choose the Mail Merge Helper button. Now the look of Mail Merge Helper 
dialog box changed and some new buttons get activated.

Choose Merge button. The merge dialog box appears. Open the Merge to 
drop-down list. Select the option from Printer, New Document, Electronic mail 
for the destination of the mail merge. Select the New Document option and 
click on the Merge button. Then you will get a new document named as Form 
Letters 1 with a copy of letter with different names and address on different 
pages.
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Summary
The word processor is the modern version of paper, pen, typewriter, eraser, 
dictionary and thesaurus… all in one. It is used to create all kinds of 
documents, from simple notes and memos, to brochures, resumes, and long 
reports. The key advantage of a word processor is its ability to make changes
easily, such as correcting spelling, adding, deleting, and relocating text. Once 
created, the document can be printed quickly and accurately and saved for 
later modifications.

In a word-processing program, a window appears for entering text, with a ruler
above to indicate the paper width and lots of little buttons with pictures on 
them. The buttons are shortcuts to certain popular commands. If mouse is 
hovered over these buttons (without clicking) a little tag will appear telling you 
what the button does.

Word processing software has various facilities like Mail merge. Mail merge 
allows standard letters to be 'personalized' by merging it with data from a 
database. The  result is a batch of letters which contain virtually the same 
information with the exception of names, addresses and any other information 
stored in a database.
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MS – EXCEL:
Introduction

Though most business computations can be handled by general accounting 
software, more complex calculations often are needed in order to help 
businesses make wise investment decisions. A computer aids the business 
person in performing these complex mathematical tasks. Perhaps the most 
common use of the computer is in financial analysis that involves the 
electronic spreadsheet use for designing solutions for complex calculations.
A spreadsheet is a grid that organizes data into columns and rows. 
Spreadsheets make it easy to display information, and one can insert 
formulas to work with the data. We use spreadsheet programs to learn about 
different kinds of things, and to make decisions. Spreadsheets are based on 
different varieties of subjects. Although electronic spreadsheets are useful in 
many areas of business, nowhere they are more helpful than in financial 
analysis, or forecasting, which determines profit margins, sales, and long term 
strategies. The reason for the great impact of the electronic spreadsheet in 
this area is its ability to answer “What if?” type queries on available data, as 
with the help of formula and function facility one can intelligently setup 
complex relationships between individual items in a table. A spreadsheet 
program uses the memory capability of computer to solve mathematically 
oriented problems. With a spreadsheet program, columns of numbers can be 
setup to keep track of money or objects. These items are stored in a place 
known as cells. The user may setup relationships and see the affect of varying 
independent quantities. With the high speed computing power of the digital 
computer, complex problems can be modeled on the computer and various 
options can be tried. For example, there is a particular icon that has a formula 
to sum up numbers that are given. This icon is called auto sum. Information 
can also be sorted and filtered.
This chapter will present an overview of the spreadsheet software and 
highlight the use of spreadsheets through its applications.

Concept and Definitions of Spreadsheet Software
Spreadsheet is a very powerful and easy to use software package, which is 
being commonly used these days. It is basically an end user application 
package. It works very well with numbers and their complex calculations. 
Spreadsheet helps to prepare data in an organized, orderly and meaningful 
fashion. Spreadsheet finds its major contribution in creating reports, using 
formulas and performing calculations. It is best suited for scientific and 
statistical analysis. Spreadsheet can also be used to prepare Profit and Loss 
accounts, Balance sheet and other Tax statements. It works well for both 
simple and complicated numbers. It can be used for preparing analytical 
reports including statistical analysis, forecasting and regression analysis. 
Good looking and attractive charts can be created which depict data in clearer 
and meaningful fashion. Spreadsheet can also used to create relationships 
between different types of data. Spreadsheet can do all the work of a full-
fledged word-processor but it lacks the advanced features of desktop 
publishing. It also supports the high level features of object linking and 
embedding which means data from word processor can be safely and easily 
put and linked with data in spreadsheet and vice versa is also true.
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Spreadsheet History1961 - Professor Richard Mattessich was the first to 
develop a computerized spreadsheet.

 1978 - Robert Frankston and Dan Bricklin invented VisiCalc, the first 
spreadsheet. It came out with the Apple II computer.  VisiCalc did very 
well  in its first year because it could run. On personal computers, could 
perform simple math formulas, and gave immediate results.

 1980 - DIF formats were invented. Data was more portable and could 
be shared with other programs.

 1980-83 - New versions of DIF, SuperCalc, and some other programs 
came out to the public.

 1983 - Lotus 123 was introduced. It allowed people to chart information 
and identify cells. For example cell A1.

 1985 - Lotus 123 number 2.
 1987 - New spreadsheet programs such as Excel and Corel Quattro 

Pro were introduced. This allowed people to add graphics. They are 
different because they include graphic capabilities.

 2001 - Spreadsheet programs in use today are Excel, Appleworks, 
Filemaker, and Corel Quattro Pro.

We can define spreadsheet in the following manner:
A spreadsheet is a software tool for entering, calculating, manipulating, and 
analyzing sets of numbers.
An electronic spreadsheet is a relational grid of columns and rows used 
to store and manipulate numeric information by means of a computer. 
The grid appears on the display screen, and data is stored in the 
memory of computer.

We have seen from historical evolution many of the spreadsheet software, 
from learning point of view we shall consider only Microsoft Excel.

Structure of Worksheet:
Start with Microsoft Excel:
To start Excel, follow the following steps:
1. Click on the Start button at windows taskbar.
2. Select Program option.
3. Select Microsoft Excel option.
4. Selecting this option will open up Microsoft Excel and the main screen will

appear.
Let us discuss the structure of Worksheet and Functions of Various 
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Components of Microsoft Excel from the main screen.
Functions of various components of Microsoft Excel are given below:

1. Title Bar: Title bar shows the name of the document and situated in 
the top of the window application.

2. Menu Bar: Menu bar contains the various commands under the 
various topics to perform some special tasks. Menu bar is located 
under the title bar

3. Standard Toolbar: Toolbar is nothing more than the shortcut of the 
Menu options to execute or perform the menu options in the easiest 
and faster way. Standard toolbar contains the commands for the 
Excel’s most frequently used commands.

4. Formatting Toolbar: Formatting toolbar contains the various 
commands related to the formatting of the document.

5. Status Bar: It displays the positioning of the cursor, displays the status 
of some important keys of keyboard, shows the messages for the 
toolbar button when a mouse points to it, display messages for menu 
option when a menu option is selected or pointed out by a user.

6. Formula Bar: Formula bar shows you the formula instead of the result 
whenever you click on a cell in which you have a formula.

7. Rows: Rows are combination of all the horizontal cells joined together 
in single horizontal line. An Excel workbook has maximum 65,536 rows 
in a worksheet

8. Columns: Columns are combination of all the vertical cells joined 
together in single vertical line. An Excel workbook has maximum 256 
columns in a worksheet

9. Cell: A Cell is an intersection point of row and column. It is used to 
store data. There are 65536 x 256 = 16777216 cells in a single
worksheet.

10. Name Box: This box shows the name or the address of the currently 
active cell.

11. Office Assistant: Office assistant provides you the online help, real-
time tips while working.

12. Scroll Bars: There are two types of scroll bars
i. Horizontal Scrollbar
ii. Vertical Scrollbar

Working of both the scroll bar is to scroll the Worksheet in the either 
directions

13. Worksheets: As name suggests it is the working area in which you can 
work. Each worksheet of a single workbook has its own identity they 
are separate from other worksheets. The maximum limit of the 
worksheet in a workbook is 255.

Creation of Spreadsheet:
Open a New Workbook
To open a new workbook, follow the steps:
1. Click on the File Menu.
2. Select Option New.
3. Click the OK Button. Now you will get a fresh new workbook to work on.
Save a Workbook
For saving a document, following are the steps:
Click Save option on the File OR Press Ctrl+S OR Press the Save Button from 
standard toolbar. If you are saving the file for the first time, the Save As… 
window
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will appear. Choose the appropriate folder from Save in combo box. Write the 
proper file name in the File name text box. And then press the Save button
Opening of an Existing Workbook
To open an existing workbook, the following steps are required:

1. Select the Open option from the File menu OR Press Ctrl+O OR Click 
on the Open tool from the standard toolbar. Then the open dialog box 
will appear.

2. Select the appropriate folder from Look in combo box.
3. Select the required file from the file window OR write the required file’s 

name in the File name window
4. Click on open button on the right hand side OR Press Enter

Closing of Workbook
To close an already opened workbook just choose the Close option from file 
menu but keep it in your mind that only the current window or workbook will 
close because Microsoft Excel works in MDI (Multi document interface) 
environment unlike notepad which works in SDI(Single document interface).
Page Setup
From the Page setup option, one can setup the page layout according to his 
work. For using the Page setup option, you have to perform the following 
steps:

1. Click on the Page setup option from the file menu. Then a window will 
appear.

2. Select the page Orientation from Portrait or Landscape.
3. Setting the Adjust to setting will Reduces or enlarges the printed worksheet.
4. Select the Adjust to check box, and then enter a percentage number in 

the % normal size box. You can reduce the worksheet to 10 percent of 
normal size or enlarge it to 400 percent of normal size.

Give the value to ‘Fit to’. Setting to ‘Fit To’ reduces the worksheet or selection 
when you print so that it fits on the specified number of pages. Select the ‘Fit 
to’ check box, enter a number in the page(s) wide by box, and enter a number 
in the tall box. To fill the paper width and use as many pages as necessary, 
type 1 in the pages(s) wide by box and leave the tall box blank.
Select the Paper size
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Print Option
For taking the printout you have to select the print option of the file menu. 
After selecting the print option from file menu the window given below will 
appear.

You can set various options before taking printout.
1. From the Name combo box, you can select the printer if more than one 

printer is installed.
2. You can select the range of pages i.e. all pages or current page or 

number of pages you require from Print range frame.
3. From the print what option you can choose that which part of a 

worksheet you want to print i.e. some selection or Entire workbook or 
active sheet only.

4. You can choose number of copies from Number of copies option under 
Copies frame.

Creating Range, Formulas and Functions:
Creating Range:

Range is a specified area from one location (cell address) to another location 
(cell address) on what some sort of operation has to be performed.

Here as shown in the window the specified area is from B3 to I18 which is 
selected with the help of mouse.
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Perform the following steps to select a range of cells:
1. Point your mouse to cell address B3.
2. By pressing the left button of the mouse drag upto cell address I18.
3. Release the button.

The range is created for performing any operation on the worksheet.
Creating Formulas:

After entering the data into the worksheet, calculations are performed with 
that data. This is done using formulas, the true power of a spreadsheet 
program. For creating the formula, syntax is required which describe the 
sequence of character used in a formula.
The syntax of a formula begins with an equal sign (=) in Excel and is followed 
by a combination of values, operators and cell references.
Operators: Operators specify the type of operation that has to be performed 
on the parts of a formula. Basically we use three types of operators.

1. Arithmetic Operators: To perform mathematical operation on numeric 
values and thereby produces numeric results.

2. Comparison Operators: To compare the values or labels in two cells. 
The result of this formula is either TRUE or FALSE.

3. Text Operators: To join one or more text values into a single combined 
text value. The ampersand (&) (which is the only text operator) is used 
to join one or more labels into a single combined label. For example,

=D2& “ “&F3
This formula combines the labels in cells D2 and F3.

Various Arithmetic and Comparison operators are shown in the table.

Arithmetic Operators Comparison Operators

Operators Meaning Operators Meaning

+ Addition = Equals

- Subtraction or Negation <> Does not equal

/ Division > Greater than

* Multiplication >= Greater than or equal to

% Percent, e.g. 35% < Less than

^ Exponentiation (e.g. 
4^2=16)

<= Less than or equal to
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When arithmetic operators are used in formulas, spreadsheets calculate the 
results using the rules of precedence followed in mathematics. The order is as 
follows:

1. Exponentiation (^)
2. Negation (-)
3. Multiplication and Division (*,/)
4. Addition and Subtraction (+, -)

Otherwise, operators are evaluated from left to right. In order to change the 
order of precedence to suit your needs, you add parentheses around any part 
of the formula that you want to be calculated first.

Creating Functions:
Spreadsheets come with many built formulas, called functions that perform 
specialized calculations automatically. We can include these functions in our 
own formulas. Some functions are quite simple, such as the COUNT function 
(to count the number of values in a range of cells). Many functions, however 
are very complex.

To insert a function you have to follow the following steps.
1. Click on the cell in which you want to insert the function.
2. Select the option Function from insert menu.
3. Above dialog box will appear.
4. Select the desired function and click on OK button

Using Various Functions in MS-Excel:
The leading spreadsheets come with hundreds of these functions. Here we 
are discussing some of the most commonly used ones with the help of 
examples:
1. Date and Time Functions

i. DATE: Represents the date number that represents a particular date.
Syntax: DATE(year, month,  day) 
Argument Type: Number, Number, 
Number Return Type: Number
Example: =date(2005, 04, 17)
MS-EXCEL returns 4/17/05
ii. DATEVALUE: Returns the serial number of the date represented by 

date_text.
Syntax: 
DATEVALUE(date_text) 
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Argument Type: Text like date 
Return Type: Number
Example: =DATEVALUE(“2005/04/17”)
MS-EXCEL returns 38459
iii. DAY: Returns the day of a date, which is represented by a serial 

number. The day is given as an integer ranging from 1 to 31.
Syntax: DAY(serial_number) 
Argument Type: Number(Date 
number) Return Type: Number
Example: =DAY(38459)
MS-EXCEL returns 17
iv. MONTH: Returns the month of a date, which is represented by a serial 

number. The month is given as an integer ranging from 1 to 12.
Syntax: MONTH(serial_number) 
Argument Type: Number(Date 
number) Return Type: Integer
Example: =MONTH(38459)
MS-EXCEL returns 4
v. NOW: Returns the serial number of the current date and time i.e. this 

function returns sum of current date number and current time number.
Syntax: NOW( )
Argument Type: 
None Return Type: 
Number Example: 
=NOW( )
MS-EXCEL returns 4/17/2005 21:58
vi. TIME: Returns the decimal number for a particular time.
Syntax: TIME(hour, minute, second) 
Argument Type: Number, Number, 
Number Return Type: Number (the time 
number) Example: =TIME(21, 58, 12)
MS-EXCEL returns 9:58 PM
vii. TODAY: Returns the serial number of current date i.e. the date number 

of current date.
Syntax: TODAY( ) 
Argument Type: 
None Return Type: 
Number Example: 
=TODAY( )
MS-EXCEL returns 4/17/2005

2. Financial Functions
i. FV: Returns the future value of an investment based on periodic, 

constant payments and a constant interest rate.
Syntax: FV(rate, nper, pmt, pv, type)
Argument Type: Number, Number, Number, Number,
Return Type: Number
Example: =FV(0.005, 18, -500, -2000, 0)
MS-EXCEL returns $11,580.75
ii. PMT: Calculates the payment for a loan based on constant payments 

and a constant interest rate.
Syntax: PMT(rate, nper, pv, fv, type)
Argument Type: Number, Number, Number, Number, Number
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Return Type: Number
Example: =PMT(8%/12,10,10000,0,1)
MS-EXCEL returns ($1,030.16)
iii. PV: Returns the present value of an investment. The present value is 

the total amount that a series of future payments is worth now.
Syntax: PV(rate, nper, pmt, fv, 
type) Argument Type: Number 
all Return Type: Number
Example: =PV(0.08/12,240,500, ,0)
MS-EXCEL returns ($59,777.15)

3. Logical Functions
Examples based on the following table:

R. No. Name Marks Grade

2001 Anil 96 A+

2002 Sanjay 43 F

2003 Jagdeep 66 A

2004 Rajneesh 55 B

2005 Renu 80 A+

i. AND: The logical functions are used to see whether a condition is true 
or  false or to check for multiple conditions.

Syntax: AND(Logical1, Logical2, ….)
Argument Type: Logical 
all Return Type: Logical 
Example: =AND(c2:c6)
MS-EXCEL returns TRUE
ii. OR: Returns TRUE if any argument is TRUE; returns FALSE if all 

arguments are FALSE.
Syntax: OR(Logical1, Logical2, 
….) Argument Type: Logical all 
Return Type: Logical
Example: =OR(c2:c6)
MS-EXCEL returns TRUE
Type: =OR(b2:b6)
MS-EXCEL returns #VALUE
iii. NOT: Reverses the value of its expression that can be evaluated to 

TRUE or FALSE.
Syntax: NOT(logical)
Argument Type: Logical
Return Type: Logical 
Example: =NOT(FALSE) 
MS-EXCEL returns 
TRUE Type: 
=NOT(1+4=5)
MS-EXCEL returns FALSE

4. Math Functions
i. ABS: Returns the absolute value of a number.
Syntax: ABS(Number) 
Argument Type: 
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Number Return Type: 
Number Example: 
=ABS(5)
MS-EXCEL returns 5
Type: =ABS(-5)
MS-EXCEL returns 5
ii. EXP: Returns e raised to the power of a number e.g. e^x. The constant 

e=2.71828182845904, the base of the natural logarithm.
Syntax: EXP(number) 
Argument Type: 
Number Return Type: 
Number Example: 
=EXP(1)
MS-EXCEL returns 2.718281828
Example: =EXP(2)
MS-EXCEL returns 7.389056099
iii. INT: Rounds a number down to a nearest integer.
Syntax: INT(number) 
Argument Type: 
Number Return Type: 
Number Example: 
=INT(8.9)
MS-EXCEL returns 8
Example: =INT(-8.9)
MS-EXCEL returns -9
iv. LOG: Returns the logarithm of a number to the base we specify.
Syntax: LOG(Number, base)
Argument Type: Number, Number
Return Type: 
Number Example: 
=LOG(10) MS-
EXCEL returns 1 
Example: =LOG(8,2)
MS-EXCEL returns 3
v. MOD: Returns the remainder after number is divided by divisor. The 

result has the same sign as the divisor.
Syntax: MOD(Number, divisor) 
Argument Type: Number, 
Number Return Type: Number
Example: =MOD(3,2) 
MS-EXCEL returns 1 
Example: =MOD(3,-
2)
MS-EXCEL returns -1
vi. ROUND: Returns a number to a specified number of digits
Syntax: ROUND(number, num_digits)
Argument Type: Number 
Return Type: Number 
Example: 
=ROUND(2.15,1)
MS-EXCEL returns 2.2
Example: =ROUND(2.149,1)
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MS-EXCEL returns 2.1
vii. SQRT: Returns a positive square root.
Syntax: 
SQRT(number) 
Argument Type: 
Number Return Type: 
Number Example: 
=SQRT(16) MS-EXCEL 
returns 4 Example: 
=SQRT(-16)
MS-EXCEL returns #NUM
viii. SUM: Adds all the numbers in a range of cells.
Syntax: SUM(number1, number2, ….)
Argument Type: Number
Return Type: Number
Example: =SUM(3,2)
MS-EXCEL returns 5
Example: =SUM(a2, b2, 2)
MS-EXCEL returns 2
ix. TRUNC: Truncates a number to an integer by removing the fractional 

part of the number.
Syntax: TRUNC(number, num_digits)
Argument Type: All 
number Return Type: 
Number Example: 
=TRUN(8.9)
MS-EXCEL returns 8 
Example: =TRUN(-
8.9) MS-EXCEL 
returns -8

5. Statistical Functions
Examples based on the following table:

R. No. Name Marks Grade

2001 Anil 96 A+

2002 Sanjay 43 F

2003 Jagdeep 66 A

2004 Rajneesh 55 B

2005 Renu 80 A+

i. AVERAGE: Returns the average of the 
arguments. Syntax: AVERAGE(number1, 
numner2, number3,….) Argument Type: All
numbers
Return Type: Number
Example: =AVERAGE(c2:c6)
MS-EXCEL returns 68
ii. COUNT: Counts the number of cells that contain numbers and 

numbers within the list of arguments.
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Syntax: COUNT(value1, value2,…)
Argument Type: Any 
type Return Type: 
Number Example: 
=COUNT(c2:c6)
MS-EXCEL returns 5
iii. MAX: Returns the largest value in a set of values.
Syntax: MAX(number1, 
number2,…) Argument Type: All 
numbers Return Type: Number
Example: =MAX(c2:c6)
MS-EXCEL returns 96
iv. MIN: Returns the smallest value in a set of values.
Syntax: MIN(number1, 
number2,…) Argument Type: All 
numbers Return Type: Number
Example: =MIN(c2:c6)
MS-EXCEL returns 43

6. Text Functions
i. CHAR: Returns the character specified by a number. The number is 

assumed to be the ASCII value and its equivalent is returned.
Syntax: 
CHAR(number) 
Argument Type: 
Number Return Type: 
Character Example: 
=CHAR(65)
MS-EXCEL returns A
ii. CONCATENATE: Joins several text strings into one string.
Syntax: CONCATENATE(text1, text2,…)
Argument Type: All Text
Return Type: Text
Example: CONCATENATE(“Ram”, “Avtar”)
MS-EXCEL returns RamAvtar
iii. LEFT: Returns the first character or the characters in a text string, 

based on the number of characters we specify.
Syntax: LEFT(text, 
num_chars) Argument 
Type: Text, Number Return 
Type: Text
Example: =LEFT(“SALES PRICE”, 4)
MS-EXCEL returns SALE
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iv. LEN: Returns the number of characters in a text string i.e. Length of a string.
Syntax: LEN(text) 
Argument Type: Text 
Return Type: Number
Example: =LEN(“SALES PRICE”)
MS-EXCEL returns 11
v. LOWER: Converts all uppercase letters in a text string to lowercase.
Syntax: LOWER(text) 
Argument Type: Text 
Return Type: Text
Example: =LOWER(“SALES PRICE”)
MS-EXCEL returns sales price
vi. RIGHT: Returns the last character or the characters in a text string, based 

on the number of characters we specify.
Syntax: RIGHT(text, num_chars) 
Argument Type: Text, Number 
Return Type: Text
Example: =RIGHT(“SALES PRICE”, 5)
MS-EXCEL returns PRICE
vii. TRIM: Removes all spaces from text except for single spaces between the 

words..
Syntax: TRIM(text) 
Argument Type: Text 
Return Type: Text
Example: =TRIM(“SALES PRICE ”)
MS-EXCEL returns SALES PRICE
viii. UPPER: Converts all lowercase letters in a text string to uppercase.
Syntax: UPPER(text) 
Argument Type: Text 
Return Type: Text
Example: =UPPER(“sales price”)
MS-EXCEL returns SALES PRICE

Data Management
Data menu of the Excel provides various commands, which you can apply to your 
data.
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Sorting of Data
To sort the data you have to perform the following steps.

1. Select the columns which you want to sort.
2. Choose Sort option from Data menu. You will find out the following dialog 

box on the screen.

3. Choose the Column on which you want to do the sorting. You can select 
more than one column.

4. Select the Ascending or descending option.
5. Select the Header row if there is any header row in the table.
6. Click on the OK button.

Filtering List
Sometimes the user wants to locate some information from an extensive list. To 
find the information quickly, Microsoft Excel provides Filter list option. This option 
enables the user to display the information regarding the selected options. 
Microsoft Excel provides two commands for filtering lists:
AutoFilter, which includes filter by selection, for simple criteria 
Advanced Filter, for more complex criteria
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Using Auto Filter
You can apply filters to only one list on a worksheet at a time.

1. Click a cell in the list you want to filter.
2. On the Data menu, point to Filter, and then click AutoFilter.

3. To display only the rows that contain a specific value, click the arrow in the 
column that contains the data you want to display.

4. Click the value.
5. To apply an additional condition based on a value in another column, 

repeat steps 3 and 4 in the other column.
Filter a List by using Advanced Criteria
Your worksheet should have at least three blank rows above the list that can be 
used as a criteria range. The list must have column labels.

1. Select the column labels from the list for the columns that contain the 
values you want to filter, and click Copy.

2. elect the first blank row of the criteria range, and click Paste .
3. In the rows below the criteria labels, type the criteria you want to match. 

Make sure there is at least one blank row between the criteria values and 
the list.

4. Click a cell in the list.
5. On the Data menu, point to Filter, and then click Advanced Filter.
6. To filter the list by hiding rows that don't match your criteria, click Filter the 

list, in-place.
To filter the list by copying rows that match your criteria to another area of the 
worksheet, click Copy to another location, click in the Copy to box, and then click 
the
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upper-left corner of the area where you want to paste the rows.
7. In the Criteria range box, enter the reference for the criteria range, 

including the criteria labels.
To move the Advanced Filter dialog box out of the way temporarily while you 
select the criteria range, click Collapse Dialog.

About importing data
By importing data, you don't have to retype the data you want to analyze in 
Microsoft Excel. You can also update your Excel reports and summaries 
automatically from the original source database whenever the database is 
updated with new information.
Importing data: You can import data to Excel from most data sources by pointing 
to Import External Data on the Data menu, clicking Import Data, and then 
choosing the data you want to import in the Select Data Source dialog box. The 
Data Connection Wizard, available when you click New Source in the Select 
Data Source dialog box, makes it possible to import data from external data 
connections not available from the Select Data Source dialog box.

Graphics on Spreadsheet:
Inserting Images, Auto shapes and Word Art
Inserting Images from Clip Gallery
To insert an image from Clip Gallery you have to follow these steps:

1. Move the cursor on the cell where you want to insert the image.
2. Select Clip art option from Insert->Picture menu.
3. Click the picture category from which you want to insert the picture.
4. If you know what type of image you are looking for, type a descriptive 

word or two in the Search for Clips text box, and press Enter. Excel 
displays the images that most closely match your keywords.

5. When you find out the image that you want to use, click it.
6. Clicking on image will display a small toolbar, from that toolbar click 

the insert button.
This will insert a clipart in your worksheet.
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WordArt
WordArt lets you add flair to your text itself. It provides a different look to your text 
as well worksheet. It is perfect for creating flashy headings and titles. To insert a 
word art in your worksheet do the following steps.

1. Click the place on the worksheet where you want the WordArt image to be
placed.

2. Choose Insert, Picture, WordArt or click on  icon. This will open 
the WordArt Gallery dialog box.

3. Choose the desired format and press Ok button.
4. Then the figure given below will appear.
5. Write the desired text instead of Write your Text Here.
6. Select the desired Font and Font size.
7. Press Ok button.

Insert Objects
Excel provides you the facility to link or embed the objects of other software’s in 
your worksheet and work on the linked or embedded objects as you are working 
on that software itself.
To embed an object you have to follow these steps.

1. Click in the document where you want to place the embedded object.
2. On the Insert menu, click Object, and then click the Create New tab.
3. In the Object type box, click the type of object you want to create.
4. To display the embedded object as an icon — for example, if others are 

going to view the worksheet online — select the Display as icon check
box.

Note:
Only programs that are installed on your computer and that support linked and 
embedded objects appear in the Object type box. When you click Microsoft Word 
Document in the Object type box, an entire document is inserted into your 
worksheet. The document displays only one page at a time. To display a different 
page, double- click the Microsoft Word object, and then click a page down button.

Insert Chart
Pictures are more understandable than words. Charts are visually appealing and 
make it easy for users to see comparisons, patterns, and trends in data. For 
instance, rather than having to analyze several columns of worksheet numbers, 
you can see at a  glance whether sales are falling or rising over quarterly periods, 
or how the actual sales compare to the projected sales.

You can create a chart on its own sheet or as an embedded object on a 
worksheet. You can also publish a chart on a Web page. To create a chart, you 
must first enter the data for the chart on the worksheet. Then select that data and 
use the Chart Wizard to step through the process of choosing the chart type and 
the various chart options.
Using chart wizard
One of the easiest ways to generate a chart from data you enter in a worksheet is 
by using Chart wizard. Chart wizard is a simple process of making selections to 
produce a finished chart.
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1. Select the range of data on which you want to make a chart.
2. Select the option chart from insert menu following dialog box will appear.

3. Select the type of chart you want.
4. Click on the Press and Hold to view Sample button to preview your chart.

5. If the given charts are not of your choice then click on the Custom Type tab.
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6. Select the graph type and Click on the Next button.
7. If you have forgotten to select the data range or you want to change the 

data range then you can select the data range from here by clicking the 
button next to Data range combo box.

8. Click on the Series tab. Following dialog box will appear.

9. You can add or remove the series (Columns) from the series list box by 
clicking add or remove button.
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10. Click on the Next button the option dialog box will appear on the screen.

11. Fill up the entries as Heading of the chart, (x) axis category heading, (Z) 
axis values heading.

12. Click on the Legend tab

13. Legend dialog box will be displayed on the screen
14. Check mark the Show legend check box to show the legends
15. Select the Placement position.
16. Click on the Data Labels Tab.
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17. Choose the type of labels you want to see in your graph.
18. Click on the Next button.

19. Select the destination of the Chart on new sheet or in the current sheet.
20. Select New Sheet and click on the Finish button.

Some future trends for spreadsheets
To a large extent, the future trends for the software industry are now available as 
part of “Office Suites” that package several programs like spreadsheet, word 
processor, drawing or presentation graphics and a database management 
program together and also offer a common interface. Group computing is another 
trend. As more companies create networks for their computers to share 
information, there is need to allow more than one person at a time to work on a 
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file. Finally, it is always desired to make it easier for use of the software.
For the future, one can expect spreadsheets to offer more special features 

for the advanced user while simplifying frequently used tasks for beginning and 
advanced users alike.
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COMPUTERIZED ACCOUNTING:

       An accounting system is a collection of processes, procedures and controls 
designed to collect, record, classify and summarize financial data for interpretation and 
management decision-making. Whether the accounting system is simple or complex, it 
must meet certain objectives to keep the business running smoothly. It is difficult to make 
informed business decisions without accurate accounting information that helps the
managers to see where the business is, where it has been and (based upon trends)
foresee where it is headed. Thus, an accounting system should be devised as an
effective tool that provides information which is easy to understand.

While some firms still do their book-keeping by hand, most firms generally have too many 
transactions to sustain a manual accounting system. The more complicated the financial 
activities of a business are, the more likely it will need a computerized accounting
system to ensure effective financial reporting. Computerized accounting systems 
involve making use of computers and accounting software to record, store and analyze
financial data. These are software programs that are stored on a company’s computer, a 
network server, or remotely accessible via Internet.

Computerized Accounting represents a technological advancement in the field of 
business accounting which allows the user(s) to set up income and expense accounts, 
such as rental or sales income, salaries, advertising expenses, and material costs. They 
also can be used to manage bank accounts, to pay bills, and prepare budgets. Also, 
depending upon the program, some accounting systems also allow users to prepare tax 
documents, handle payroll, and manage project costing.

DIFFERENCE BETWEEN MANUAL AND COMPUTERISEDACCOUNTINGSYSTEM

BASIS MANUAL ACCOUNTING COMPUTERIZED ACCOUNTING

1. Definition

`

Manual accounting is the system in 
which we keep physical register of 
journal and ledger for keeping the 
records of each transaction.

In this system of accounting, we 
make use of a computer and 
different accounting software for 
maintaining a digital record of every 
transaction.

2. Ledger 
Accounts

We check the journal and then we 
transfer figures to related accounts 
debit or credit side by manually 
posting it.

Computerized Accounting System 
will automatically process the 
system and will make all the 
accounts’ ledgers since the 
voucher entries under its respective 
ledger account have already been 
passed.
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3. Trial
Balance

We collect the information of all the 
balances of all accounts in our 
ledger, and on this basis we 
manually prepare the trial balance.

The computerized accounting 
system will automatically produce 
the Trial Balance.

4. Adjustment 
Entries 
Record

Both, the adjustment journal entries 
and its posting in the ledger 
accounts will be done manually, one 
after another.

Only adjustment entries will be 
passed in the computerized 
accounting software, these will then 
be automatically posted to 
respective ledger accounts.

Advantages of Computerized Accounting

There are many advantages of computerized Accounting System. Let us discuss few of 
them in detail.

1. Automation: As all the calculations are handled by the software, computerized accounting 
eliminates many of the mundane and time-consuming processes associated with manual 
accounting. For example, once issued, invoices are processed automatically thus saving
time.

2. Accuracy: This accounting system is designed to be accurate to the minutest detail. Once
the data is entered into the system, all the calculations, including additions and subtractions, 
are done automatically by software.

3. Data Access: Using accounting software, it becomes much easier for different 
individuals to access accounting data outside the office, securely. This is particularly true if 
an online accounting solution is being used.

4. Easy representation of data in various formats: Viewing the accounts using a
computer allows the users to take advantage of the option to view the data in different 
formats i.e. one can view data in tables and using different types of charts.

5. Reliability: Since the calculations are very accurate, the financial statements prepared by 
computers are highly reliable.

6. Scalable: When a company grows, the number of transactions entered into the system
increases, as a result of which the need for accounting not only increases but also 
becomes more complex. With computerized accounting, everything is kept straight forward
because shifting data using software is easier than sifting through a bunch of papers.

7. Speed: Using accounting software, the entire process of preparing accounts becomes 
faster. Furthermore, statements and reports can be generated instantly at the click of a
button. Managers do not have to wait for hours, even days, to lay their hands on an
important report.
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8. Security: The latest data can be saved and stored in offsite locations so it is safe from
natural and man-made disasters like earthquakes, fires, floods and terrorist attacks. In case
of disasters, the system can be quickly restored on other computers. This level of 
precaution is taken by Computerized Accounting.

9. Cost-effective: Since using computerized accounting is more efficient than paper-based 
accounting, than naturally, work will be done faster and time will be saved.
Disadvantages of Computerized Accounting

Computerized Accounting suffers from many limitations. Let us discuss those limitations 
one by one.

Cost of Software: In case of computerized accounting, you must buy the software. 
Some software requires you to purchase upgrades or updates for additional features.
You must also ensure your computer is capable of running the software. If not, you’ll
need to upgrade your computer as well.

Most accounting software requires you to have additional software in order to view 
reports. For instance, some programs allow you to export data as a PDF file or an Excel 
spreadsheet. This allows users without the accountingprogram to view the data. However,
the viewing software may pose an additional expense to the user.

2. Reliance on Computers: If your computer crashes or data is corrupted by a virus, you 
won’t be able to use your accounting software until the problem is fixed. This also 
means you won’t have access to any entered data until the computer is running again.
Your data can also be corrupted. It means you will have to re-enter information unless 
you’ve backed up your files. In addition, if there’s a power failure, your software will be 
unusable unless you’re on a battery-powered laptop.

3. Fraud: Accounting software data requires extra levels of security to prevent fraud and
embezzlement. Software makes it easier for users to alter data, making fraud easier to
accomplish. As a result, there is an increased need for internal auditors to check for any 
data inaccuracies. Security measures must also be taken to limit the amount of control 
users have over any accounting software’s features.

4. Human Error: While it is easy to write down numbers incorrectly, it is even easier to 
mistype a number. Entering data into accounting software too quickly may result in 
serious errors. With the program performing calculations, it can be more difficult to trace 
the cause of the problem. Spreadsheets, digital ledgers or written ledgers make tracking 
simpler and faster.

5. Training: Accounting software requires you to take the time to learn how to use it. While 
you may be an experienced accountant, you’ll still need to learn what each button and 
menu command does in order to use accounting software effectively. This learning curve can
result in costly affairs. In some cases, paid training may be necessary to learn how to 
perform certain tasks. If you’re not tech savvy, the process could be even more difficult.

6. Time: Many accountants find that it takes more time to enter data into accounting 
software than it does to write it or type it into a spreadsheet. Due to step-by-step
screens, the process often takes longer, especially for those who don’t use the software



59

often or are still new to using the program. If the software requires numerous steps to 
enter basic data, the time requirements may outweigh the benefits of automatic
calculations.

ACCOUNTING SOFTWARES IN INDIA:

In a computerized accounting system, the framework of storage and processing of data is 
called operating environment that consists of hardware as well as software in which the
accounting system works. The type of accounting system used determines the operating
environment.

Some of the most prevalent business accounting software systems are:

1. Tally ERP.9: Tally ERP.9 is a business accounting software for the purposes of 
accounting, inventory and payroll. Tally has been one of the dominating accounting 
software for almost two decades. The software has been developed by Tally Solutions Pvt 
Ltd. It is the most user-friendly for accounting software and thus, employers prefer Tally 
for easy availability of trained professionals for this specific software. Almost all 
accounting activities like inventory, purchase, sales, cost, payroll and statutory year end 
processes can be easily handled by Tally.

2. Profitbooks: This is an Online accounting software developed for small enterprises. It 
can only be operated on the internet as it is cloud based. The data can be securely 
placed in a cloud and can be accessed anywhere.

3. Marg: Accounting Software is developed by Marg Compusoft Pvt Ltd and is well 
accepted in small and medium enterprises of India. The software is marketed for the last
two decades in the Indian market.

4. Wave: Wave’s accounting tools are 100% free, secure, and very popular in accounting 
community. It is one of the best web based accounting software solution available at
present.

5. Xero: Developed by Xero, it is an award winning web based accounting software for 
small business owners and accountants. The user interface is nicely designed and is
easy to use for online bookkeeping.

6. Reach: Reach Accounting Software is developed by Reach Accountant. It is an online 
Accounting Software aimed at Small & Medium Businesses. The significant part of Reach 
is that all the business operations are bundled in single software and it ensures that the 
business owner is able to track every aspect of the business.

About Tally Software

Tally ERP.9, developed by Tally Solutions Ltd., is one of the most popular and widely 
used business management software available in India and other countries. It can be
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used by small to large business organization. It is available with two types of licensing
system:

1. Silver Edition Mode (Single user): It is for single use PC. It can be activated online or 
offline. It can be accessed from the system on which

it is installed by only a single user.

How to Start Tally ERP.9

Go to start button, click ‘all programs’. With in ‘All Program’, go to Tally ERP.9 or installation 
of Tally icon on the desktop. If you double click on Tally icon, Tally will open and you
can start working on it.

Components of Tally

The gateway of Tally displays menus, screens, reports and options that you select. The 
components of Tally ERP.9 are:

 Top Horizontal Button Bar: This is a collection of buttons that are fixed and provide 
quick interaction

 Close Button: This helps in moving out of Tally application.

 Screen Name: It shows the name of the current screen.

 Right Pane: In right pane menus are displayed. The red letter in each menu represents 
short cut and by pressing that alphabet from keyboard one can open the menu.

 Left Pane: It shows current period, current date and name of companies with last date 
of voucher entry done in each company.

 Vertical Panel Bar: It is used for quick interaction.



 Calculator: It can be used for calculation work and figures can be computed. (Ctrl +

 Information Panel: This displays details 

 Task Bar: It shows the complete navigation path of the current menu or screen
selected.

Procedure of Creating a Company

To create a company, click on the 
‘create company’ in ‘Company Info’. 
Alternatively, one can press
and the company info screen
appear as appeared in Fig. 18.2.

The various fields appearing in 
company creation in Fig. 18.3 are 
explained below:

 Directory: It will display the path 
where your company data is stored. 
By default, it would automatically be 
stored in Tally ERP.9 data folder, but

can be used for calculation work and figures can be computed. (Ctrl +

displays details of product, version, licenseand configurations.

shows the complete navigation path of the current menu or screen

Company

click on the 
‘create company’ in ‘Company Info’. 

ALT+ F3
screen will
18.2.

The various fields appearing in 
company creation in Fig. 18.3 are 

will display the path 
where your company data is stored. 
By default, it would automatically be 

data folder, but
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can be used for calculation work and figures can be computed. (Ctrl +

configurations.

shows the complete navigation path of the current menu or screen
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you can change its path and can specify any location where you want to store the data 
relating to the company by pressing backspace key

 Name: It means providing a name to the company. Example: Surbhi Ltd.

 Primary Mailing Details:

Mailing Name: You can specify any other name if you want for mailing purpose. By 
default, it will always show the name which you have entered in the Name field earlier

Address: Provide the address of the company in this field

Statutory Compliance: Choose the country in which the company is located. For example,
we have selected India.

State: Choose the state in which the company is located. For example, we have 
selected Delhi.

Pin-code: Provide the Pin code for the company where it is located.

 Contact Details
 Provide telephone number, mobile number and Fax number (if any) of the company. Also,

provide the official email address of the company which would be further used for
emailing of reports and statements.

� Auto-Back up: Putting ‘Yes’ to enable auto backup will result in automatically creating
backup of the data of the company in the company data folder.

� Company Details:

Currency Symbol: Once country is selected, Tally will automatically choose the currency of 
the country. In this example, we have selected India, so currency symbol would be of
‘Rupee’.

Maintain: If company maintains inventory with them, select accounts with inventory 
otherwise accounts only. Selecting accounts with inventory would combine both financial 
accounts and inventory books.

Financial Year: Financial year is a period of 12 months starting from 1st April. The

accounting period in this example, will begin from 1st April, 2017.

Books beginning from: Provide a date at which you started maintaining your books. It

can be a date later than 1st April, 2017. By default, it would automatically take date 
mentioned in previous field.

� Security Control:

Tally Vault Password: Entering this password will require, opening the company with
password each time. The name of the company having tally vault password will be shown
with asterisk ‘*’ mark.

Repeat Password: Password entered in various field has to re-enter for confirmation.
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Use Security Control: Enabling this field as ‘Yes’ will allow to define access administrator 
user name and password. Every time you open a company, it would ask for name of
administrator and password.

� Base Currency Information:

Base Currency Symbol: The selection of country will define base currency symbol. In this
example, we have selected India, so currency symbol would be of ‘Rupee’

Formal Name: The formal name of the currency like INR (Indian Rupee) will be
displayed.

Suffix Symbol to amount: This will allow putting symbol of currencyafter the amount.

Add space between amount and symbol: This will allow space between amount and
symbol.

Show amounts in millions: This will allow the values of amount to be expressed in millions 
i.e. international system of numeration.

Number of Decimal Places: By default, it will be set to 2 places only and Indian currency 
has 2 decimal places whereas some currency has 3 decimal places. It can go upto 4 
decimal places.

Words representing amount after decimal: By default, it will be automatically set 
according to currency.

Accounting Features

The accounting features consists of general, outstanding management, cost/ profit 
centres management, invoicing, budgeting and scenario management, banking features
and other features as shown in Fig. 18.17:

� General: If you have chosen accounts with inventory while creating company, maintain
accounts only option will be set as ‘No’ and integrate accounts with inventory option as 
‘Yes’. If you have chosen accounts only while creating company, maintain accounts only 
option will be set as ‘Yes’ and integrate accounts with inventory option will not be 
highlighted and will be grey in color. If you wish to have income and expenditure account 
in place of Profit and loss account (Like for NPO) you can enable this as ‘Yes’.

� Outstanding Management: This will help maintain bill wise details and also, calculate interest 
on outstanding.

� Cost/Profit Centres Management: It helps in maintaining payroll and cost centres.

� Invoicing: To enable recording purchase in invoice mode, type ‘Yes’.To record sales and 
purchase return, debit and credit note is used. Set Debit and credit note as ‘Yes’

� Budgeting and scenario management: To maintain budget, enable the option
as “Yes’.

� Banking Features: To enable cheque printing, enable cheque option as ‘Yes’.



� Other Features: To enable zero valued transactions while
transactions, enable this option as

After carrying out all requisite
tally screen will appear as follows

Inventory Features

The inventory features consists of general, storage and classification, order 
processing, invoicing, purchase
inventory feature by clicking it or pressing 
on the vertical button bar on right pane. Once 
appear as shown in Fig. 18.19:

In general, integrate accounts and inventory will be set as 
accounts with inventory while creating 
transactions, set this option as 

In storage and classification, 
warehouse, enable maintain multiple 
category wise, enable maintain stock categories as 

Set invoicing as ‘Yes’ and use
discount in invoice in separate column, enable this option as

After all settings, the screen will

enable zero valued transactions while recording
transactions, enable this option as ‘Yes’.

changes in accounting features, Accept ‘yes’
follows as shown in Fig. 18.18:

consists of general, storage and classification, order 
purchase and sales management and other features.

inventory feature by clicking it or pressing ‘I’ or pressing F2 or by clicking F2: inventory 
on the vertical button bar on right pane. Once you do so, the following

18.19:

general, integrate accounts and inventory will be set as ‘Yes’ if you 
inventory while creating company. If you want to enable 

transactions, set this option as ‘Yes’.

classification, if you want to maintain stock according 
warehouse, enable maintain multiple godowns/locations as ‘Yes’. To 
category wise, enable maintain stock categories as ‘Yes’.

use debit and credit notes in invoice mode as
discount in invoice in separate column, enable this option as ‘Yes’.

will appear as follows as shown in Fig. 18.20:
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‘yes’ or ‘No’. The

consists of general, storage and classification, order 
features. You can open 

or pressing F2 or by clicking F2: inventory 
following screen will

you have selected 
enable zero valued 

maintain stock according to location or 
To maintain stock 

‘Yes’. To record 

18.20:



and accept ‘Yes’ to proceed further:

18.8.1.3 Statutory and Taxation

Next feature is Statutory and taxation
pressing ‘S’ or pressing ‘F3’ or by clicking ‘F3’: statutory on the vertical button bar on 

in 

to
requirement. To enable GST,
with set/alter details option. Suppose, 
as ‘Yes’ .

and accept ‘Yes’ to proceed further:

Taxation Features

Statutory and taxation. You can open inventory feature by clicking it or 
pressing ‘S’ or pressing ‘F3’ or by clicking ‘F3’: statutory on the vertical button bar on 

right pane. Once you do 
so, the following screen 
will appear as shown in 
Fig. 18.21:

Please note statutory 
compliance is country 
specific. Since we have 
selected India as option 
statutory compliance 
therefore the displayed 
statutory and taxation 
features are those that 
are relevant to India. One 
can set these according
business

VAT, Service Tax, TDS & TCS enable option as 
Suppose, GST is relevant to our business, then setting GST 
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. You can open inventory feature by clicking it or 
pressing ‘S’ or pressing ‘F3’ or by clicking ‘F3’: statutory on the vertical button bar on 

right pane. Once you do 
so, the following screen 
will appear as shown in 

. 18.21:

Please note statutory 
compliance is country 
specific. Since we have 
selected India as option 
statutory compliance for, 
therefore the displayed 
statutory and taxation 
features are those that 
are relevant to India. One 
can set these according

specific
option as ‘Yes’ along 

GST is relevant to our business, then setting GST 


